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Ten tips for great scientific illustrations

1. Know your audience.
    Don’t illustrate what they already know, clarify what they don’t.
2. Tell your story. Started here (hunch), did this (experiments), and ended up somewhere
    (conclusions). Keep the components (colors, shapes, views, etc.) consistent from
    illustration to illustration.
3. Create interest and stimulate imagination.
4. Control: move the reader through the illustration
    Left to right, top to bottom.
5. Color: only when necessary, use it to direct focus.
6. Humor: but only if appropriate to the subject matter.
7. Human: add face, hand, body, etc. humans love to see humans.
8. New ideas: require simple illustrations.
    Let the idea take focus not the illustration.
9. Technical text = technical graphic, add parts or sections to clarify.
10. In general, never use the defaults, they are always WRONG!

Never hesitate to invest in good graphics. They pay for themselves by clarifying your research and 
data to those around you.

Convert your "My Molecule" talk into a poster

Poster size is:
43" Wide x 30" High.
Instructions begin on page 39, you can create your poster in Adobe Illustrator, Apple Pages or Microsoft 

PowerPoint

The "My Molecule" Poster should be submitted to the Media Center for printing:
http://jobboard.biochem.wisc.edu/ (or bring it on a USB Flash Drive) by 12/09/2008.

You must hang your poster in the main hallway of the 1998 Biochemistry Addition by 9:00 am on 12/11/2008. 
Please pick any of the available boards and display. If you need thumbtacks you can get some from your 
lab or the Media Center.
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Scientific Illustrations 101
Brought to you by the Information Technology & Media Center (ITMC)
 Department of Biochemistry, University of Wisconsin, Madison, WI 53706

In this tutorial you will learn the following:
My Molecule poster due dates ..................................................................................... Facing page
Ten tips for great scientific illustrations .................................................Facing page and Handout
PyMOL default atom colors ..............................................................................................Handout
Color basics – what, where and why? ...............................................................................Handout
Vector vs. Bitmap, two kinds of image file formats ......................................................................2
Basic Adobe Photoshop .................................................................................................................3
Basic Adobe Illustrator ..................................................................................................................7
Adobe Illustrator - Graphing .......................................................................................................13
Google Image Searching .............................................................................................................17
Google Scholar ............................................................................................................................18
NCBI  (National Center for Biotechnology Information) searching ...........................................20
Images from Journals (using PubMed and HighWire) ................................................................22
Images from PDF files .................................................................................................................29
Correctly inserting images into Microsoft PowerPoint ...............................................................27
Creating poster in Adobe Illustrator ............................................................................................39
Five general rules for poster layout and presenting poster information ......................................44
Printing your poster .....................................................................................................................46
Creating a poster in Microsoft PowerPoint .................................................................................47
Converting a PowerPoint talk to a PowerPoint poster ................................................................53

You can also find these and other tutorials on our web site:
http://www.biochem.wisc.edu/medialab

Please call with any questions during the day, 
7:30 am to 5:30 pm – main phone number: 262-0622 
Email all three of us 
medialab@biochem.wisc.edu

H. Adam Steinberg 
Senior Artist, Scientist 
adam@steinbergs.us
265-4982 

ITMC
(The Information Technology & Media Center)
Room 401 
433 Babcock Dr 
Madison, WI 53706 

Laura Vanderploeg 
Senior Media Specialist 
vanderploeg@biochem.wisc.edu
262-5114

Robin Davies 
Media Specialist
rodavies@wisc.edu
262-5116
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There are two kinds of Images – Bitmap & Vector

Adobe Photoshop - Bitmap
• Scanned images
• Files created in Adobe Photoshop, Adobe Elements,
 CorelDraw, etc.
• Made of pixels that represent an image
• Pixels are always shades of gray
• Color images are layered grayscale files
  Three channel layers in a RGB file
  Four channel layers in a CMYK file
• Bitmap files are resolution (dpi or ppi) specific
• Should not be scaled up, pixels may become visible
• Can be scaled down through interpolation and 

resampling
• Cannot contain vector information but may be saved as 

postscript files (PDS, Photoshop native files may contain 
vector information)

• Some bitmap images can be heavily compressed
• File formats are: PS, EPS, PDF, TXT, TIFF, BMP, PCX, 

and PICT
• Web file formats are: JPEG, JPEG2000, GIF, PNG

Adobe Illustrator - Vector (Postscript)
• Computer files created from lines, fills and text
• Written in postscript language
• Files created by Adobe Illustrator,
 Deneba Canvas, CorelDraw, ClarisWorks, etc.
• Can be scaled to any dimension and still look good
• Sometimes the files are large, poor compression
• May contain bitmap information
• PDF files are a form of Postscript.
• File formats: PS, EPS, PDF, and TXT (may be ASCII or 

binary)

Pixels

Vector art shown
as wireframe

Vector art
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Basic Adobe Photoshop

You will learn the following:

How to select areas with the Rectangular Marquee Tool
How to move areas with the Move tool
How to crop images
How to adjust an image histogram using Levels

Rectangular Marquee Tool
1. Open Adobe Photoshop. On the Macintosh move the mouse to the dock (at the bottom or left of the 

monitor) and click on the program.
2. Open the file ARGs.tif and we will combine the three lanes in the right ARG with the three lanes in 

the left ARG.
3. Click on the Rectangular Marquee tool. Notice if you hover over any tool in the toolbox (without 

clicking it) that a yellow highlight will appear with the name of the tool. This works in all Adobe 
and Microsoft programs.

4. Drag a box over the three lanes on the right ARG by clicking in the upper left and dragging down 
to lower right, just like it is shown in the example below.  If you do not get the area you want with 
the first try, click on the image outside of the marquee area and it will deselect. Then redraw another 
more accurate marquee window.

Drag
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Move tool
5. Click on the Move tool.
6. Click and drag on the marquee area with the Move tool to move the right lanes over to the left lanes, 

Align the dark top bands from the right ARG with top dark band in second lane on the left ARG (see 
image below). If you hold down the option or alt key while you drag the selection you will make a 
copy of the selection instead of cutting it out.

Crop tool
7. Click on the crop tool.
8. Click anywhere on the image to deselect the marquee selection.
9. Drag the Crop tool over all six lanes (the area you want to keep) from upper left to lower right. The 

non-selected image area will darken. Notice the little squares in the corners and the centers of the 
outside lines of the crop area? You can click and drag on those squares to reshape the crop area. 

10. Hit the Return key or double-click the Crop tool inside the cropped area to crop the image.

Drag

Move
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Levels adjustment
11. Open: Image–Adjustments–Levels.

12. Notice that the histogram representing all of the pixels in this image is shifted to the left.

13. Look at the three small triangles under the histogram.
Left arrow - Black triangle: represents the number of pixels that are displaying at 100% black.
Middle arrow - Gray triangle: represents all of the pixels that are displaying at 50% black.
Right arrow - White triangle: represents all of the pixels that are displaying 0% black (these are 

the white pixels).
The ARGs.tif file looks dark because all of the pixels that are supposed to be displayed at 0% black 
(white) are shifted to ~55% black. Slide the white triangle left (0% black) over to the right end of 
the histogram and then click OK (see example below). Notice how the image lightens and correctly 
displays the pixels at the their correct brightness level? If you open the Levels window again you 
will see that the histogram now correctly represents the pixels in the image. Most of the pixels of 
the image are light in shade and so the large “hump” in the histogram is in the 5 to 30% white (0% 
black) region. 

11. You may save the file with new name to the desktop. 

Histogram Shifted left
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Basic Adobe Illustrator

You will learn the following:

RGB vs. CMYK
Placing images or text
Zoom Tool and View menu
Character palette
Paragraph palette
Type Tool

RGB vs. CMYK
1. Open Adobe Illustrator.
2.  Choose File–New.

 You will be presented with a New 
Document dialog box. Choose RGB for 
the Color Mode. Almost all of the files 
you create with Adobe Illustrator will be 
done as RGB files. RGB files are used in 
PowerPoint presentations, Posters and on 
the web, CMYK files are used for journal 
printing only.

Place command
3.  From the File menu choose Place. Use the Place 

command to insert text from Microsoft Word or bit-
mapped image files such as PICT, TIF, JPEG, GIF, 
PSD, EPS, etc. into Adobe Illustrator. Do not use the 
Place to insert Vector image files such as PRN, PS, 
EPS, PDF, and TXT (ASCII & binary) from programs 
such as Adobe Illustrator, Macromedia Freehand, 
Deneba Canvas, CorelDraw, ClarisWorks, etc or from 
"Print to File" commands. Simply use File Open for 
Vector illustrations and images. For your convenience, 
Adobe Illustrator will open or place almost any file 
format!

4.  In the directory window choose the file ARGs1.tif 
from the Photoshop exercise.

Constrain and copy shortcuts
Transform and Duplication
Moving objects with the Arrow keys
Black vs White selection tools
Rectangle Tool
Fill and Stroke
Basic Graphing
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Zoom tool and View Menu
5. Click on the zoom tool. The zoom tool works in 

three different ways:
1). You can click on an image and zoom in.
2). You can hold down the option or alt key and click 

to zoom out. Notice when you do this the plus 
sign in the middle of the magnifying lens turns 
to a minus sign (to show you zoom out).

3). You can click and drag a zoom window over a 
space and it will zoom into exactly that space.

Try all three. You can also Zoom in an out of an Illustrator 
window by using the options in the View menu (below 
left). Try Zoom In, Zoom Out, Fit in Window, and Actual 
Size from the View menu. When you are finished, choose 
Actual Size from the View Menu and drag a box over the 
ARG with the zoom tool (see example at right).

Drag
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Basic labeling with Adobe Illustrator

Character palette
6. From the Window menu, choose Type, then 

Character (image right). The Character Palette 
will open. Note: If the Character palette is 
already open, the word Character will have 
a check mark next to its name in the window 
menu. If this is the case, you only need to find 
the palette on your screen. Click on three little 
gray lines next to the tiny triangle in the upper 
right corner of the palette and choose Show 
Options. Also notice the options for Superscript 
and Subscript hidden under this triangle.

Paragraph palette
7. From the Window menu choose Type and 

then Paragraph. The Paragraph Palette will 
open. Click on three little gray lines next to 
the tiny triangle in the upper right corner of the 
palette and choose Show Options.
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Type tool
8. Click on the Type tool
9. Click the Type tool right above the middle of the 

first lane of the ARG. Type the capital letter “X”. 
Select (block off) the letter “X”. Center the letter 
“X” by clicking on the center text image in the 
paragraph palette.

Constrain and copy shortcuts
10. Click on the Direct Selection tool (the white arrow 

tool).
11. Click on the letter “X”, and then with your left 

thumb and fore finger, hold down the shift and the 
option or alt keys on the left side of the keyboard 
while you drag the “X” to the right with the 
mouse, placing it over the second lane of the ARG. 
You must let go of the mouse button first and then 
the shift and option or alt keys second. Notice that 
the cursor changes to two triangles, one black and 
one white whenever you hold down the option or 
alt key and drag an object with the white arrow 
tool. This is Illustrator's way of telling you that it 
is duplicating the object. You hold down the shift 
key to constrain the movement of the cursor to a 
perfectly horizontal line. Holding down the shift 
key will constrain the movement of the cursor 
up, down, left, right and also to 45 degrees in any 
direction. This "constraining" shortcut is adjustable 
in the preference panel and works in all Adobe and 
Microsoft programs since it is a function of the 
operating system.

Transform and Duplication
12. Choose Object–Transform–Transform Again – four times (or you could hold down the Command key 

and hit the D key, which is the shortcut for this action, circled below). 

Center text
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 The letter X will move to the right and duplicate itself four times! By duplicating your text this way you 
will get the same size and style font for all of your text. You may notice that you didn't exactly duplicate 
the text over the second lane of the ARG when you option or alt dragged it, so when you duplicated 
the text three more times it didn't exactly line up with the other lanes of the gel. We will now fix the 
alignment!

Move objects via the Arrow keys
13. Take the white arrow tool and click on one of the misaligned “X's”. Using the Arrow keys on the 

keyboard you can make the text move a small distance to the left or the right. If you hold down the shift 
key and then click on the arrow keys on the keyboard the text will move ten times as far. Do this to get 
your “X's” in visual alignment with the lanes of the ARG. This shortcut is adjustable in the preference 
panel and works in all Adobe and Microsoft programs.

14. With the type tool change the “X's” to "1", "2" , "3", etc.

Black vs. White selection tools
15. With the white arrow tool drag a box over all the lane numbers exactly as you see below. Note: Do not 

include any of the ARG image below the numbers. 

 Notice that all of the numbers will be selected. The White arrow tool selects parts of objects in three 
different ways.
1). If you click on any part of an object, that part will be selected.
2). If you option or alt click on any part of an object the entire object will be selected.
3). If you drag a box over any part(s) of an object that/those part(s) will be selected. The Black arrow 

tool, the Selection tool, selects whole objects in the same way. The black arrow tool will also allow 
you to rotate and scale selections while the white arrow tool will not.

Drag
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15. While you have all of the numbers selected, click 
and drag on one of them, dragging them to the 
bottom of the ARG lanes while you hold the option 
and the shift keys (duplicating and constraining 
them).

17.  Label the top of the ARG with percentage points. 
Change the top "1" to "MW", the top "2" to "0", the 
"3" to "25", the "4" to "50", the "5" to "75" and the 
"6" to "100"

Rectangle tool
18. Click on the Rectangle tool
19. Draw a box from between the "MW" lane and the 

“0” lane to the right of the "100" lane.

Fill and Stroke 
20. Change the black fill to none by clicking on the Fill box, then by 

clicking on the small box with the red slash through it located 
below the Fill and Stroke boxes. Change the stroke to black by 
clicking on the Stroke box and then by clicking on the small Color box below it (see example at right).

21. Click the White Arrow tool and then click on a 
blank area of the  desktop to deselect the box you 
just drew.

22. Click once on the bottom line of the box (this 
will select just the bottom part of the line) and hit 
delete.

23. With the White Arrow tool click on the "50".
24. Move the "50" up above the box while holding down 

the shift and option key to constrain and duplicate 
it.

25. Change the "50" to the word "percent".
26. In the View menu, choose Fit in Window.

Fill Stroke
NoneColor

Drag

Drag
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Basic graphing with Adobe Illustrator

27. Click on the Graph tool in the toolbox. Notice that some of the 
tools in the toolbox have a tiny black triangle in the lower right 
corner. Tools with this triangle are called nested tools. If you click 
and hold down on one of these tools it will expand out and show 
you all of the options for that tool. Expand out the Graph tool and 
choose the Scatter Graph tool.

28. Drag a big square box (like the example below) with the Graph tool above the labeled ARG from "0" to 
"100" percent. Notice that a data entry window will automatically open.

29. Adobe Illustrator requires you enter data with the Y values in the first column and the X values in the 
second column, etc. Enter the following data in column 1: 90, 0, 70, 80, 30 and the following data in 
column 2: 1, 2, 3, 4, 5. Then click on the Check mark in the upper right of the data window to apply the 
data.

Y X Y X Y X Y

Drag

Data entry window
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30. Notice that the fonts on the graph are too small and the 
X and Y tick marks are inside the graph area.

 Click on the White Arrow tool and drag a selection 
box over the entire graph.

31. In the Character palette change the type to 12 points. 
Notice that if you click on the TT in the Character 
palette that Illustrator will select the information in 
the TT box for you, making it easier to enter text. All 
Adobe palettes work this way.

32. Select the White Arrow tool and click on a blank part of the illustration to deselect everything. Drag 
a selection box over the Y axis numbers, just as it is pictured below. Do not allow any of the dotted 
selection box to touch any part of the graph. Arrow the Y axis values left with the keyboard arrows or the 
Shift + Arrows.

Drag

Drag
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33. Do the same thing for the X axis. Notice that the selection box does not touch any part of the graph.

34. Using the White Arrow tool, option double-click on the Y axis tick marks, this will select all of them as 
a group. Arrow them left with the keyboard arrows or the Shift + Arrows. 

35. Do the same for the X value tick marks.

You are finished, your labeled ARG should look similar to the image on the next page.

Drag
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Google image searching

You will learn the following:

How to use Google to find illustrations for Posters and Talks

1. In a web browser go to: http://www.google.
com.

2. Click on Images, type VDR, the common 
reference for Vitamin D receptor, and then on 
Search. There are 211,000 hits & none of them 
seem to be what we want!

3. Type vitamin d receptor or click on the Google supplied suggestion.
 There are 41,000 hits & the second one is what we want!

 Notice that you can filter your results by size (Large/Medium/Small) from the drop down box
 in the upper left of the window, allowing you to find the largest image size quickly.
4. You can get a more accurate search if you enclose what you are searching for in quotation marks. 
 Searching for [“Vitamin D receptor”] will only find images that match all three of these words.
 Searching for [Vitamin D receptor] (no quotes) will find all images that match [Vitamin], all
 images that will match [D], all images that match [receptor], but the search engine will show
 you results which are weighted to matching all three words. This is an important distinction
 because the two searches will bring you different results.
5. Narrow your search by file type:
 .jpg, .jpeg, .gif, .tiff, .pdf, .bmp, .png and on and on. In the google search box simply type what
 you are looking for, followed by a space, a colon, a period, and then the three letter file format
 or extension code: e.g.  "vitamin d receptor" :.gif. This will only bring you back results that match
 the search term and are gif files. Add an additional search parameter for location: e.g. "vitamin d
 receptor" :.gif :.ucr.edu. Now you only get results that occur on the ucr.edu server.
6. Click on the image and load largest version available into the browser.
 Then right mouse click on the image and download it to your hard drive.
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Google Scholar

You will learn the following:

How to use Google Scholar to find publications

Google Scholar gives you results that represent a body of scholarly work. This may include one or more related 
articles, or even multiple versions of one article. For example, a search result may consist of a group of articles 
including a preprint, a conference article, a journal article, and an anthology article, all of which are associated 
with a single research effort.

Each search result contains bibliographic information, such as the title, author names, and source of publication. 
One set of bibliographic data is associated with the entire group of related articles and is Google's best estimate 
at the representative article for the group. This bibliographic data is based on information from the articles in the 
group, as well as on citations to these articles from other scholarly works. 

In a web browser go to: http://scholar.google.com/.
Type "eckmann cr", an author's name, in the search field and hit Search.

Click on the following links so you can see how they work:
1.   Title –  Links to the abstract of the article, or when available, the complete article. This link will download 

the pdf file, or take you directly to the journal web page that has the pdf and/or html version of the paper.
2.  Library Links (online) – Locates an electronic version of the work through your affiliated library's resources; 

appears automatically if you're on campus. Our campus and many others use a program called Find it.
3. Cited By – Identifies other papers that have cited articles in the group. Clicking this link will take you to a 

list of all 68 publications that cite this article.
4.  Related Articles – Finds other papers that are similar to articles in this group. Clicking on this link will take 

you to 101 articles that are similar to this one.
5.  View as HTML – Clicking on this link will open the pdf file in the browser window.
6.  Web Search – Searches for information about this work on Google. For this publication Google will search 

for the following: "Wang" "regulatory cytoplasmic poly".
7.  BL Direct – Purchase the full text of the article through the British Library. Google receives no compensation 

from this service.
8.  All Versions – This link will give you a list of all locations where you can download this pdf file.

Now try it on your own. Enter your name, or any author, or search term related to your MyMolecule project and see 
what you get!

1

8

2

43 5 76
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NCBI searching

You will learn the following:

How to all NCBI databases at once!

NCBI (National Center for Biotechnology Information) is a national resource for molecular biology information. 
NCBI creates public databases, conducts research in computational biology, develops software tools for analyzing 
genome data, and disseminates biomedical information.

In a web browser go to: http://www.ncbi.nlm.nih.gov/.
Type "vitamin receptor" in the search field and click Go, or better yet, enter the topic of your "My Molecule" 
project!.
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Notice all of the wonderful things you can quickly 
get with this one search!

The entire group of individual Entrez databases 
is organized on this page with literature databases 
at the top including PubMed, PubMed Central, 
Journals, Books, OMIM and OMIA. The NCBI 
Site Search is also listed. The sequence databases 
include Nucleotide, Protein, Genome, Structure, 
and SNPs. The remaining databases are Taxonomy, 
Gene, UniGene, HomoloGene, Conserved 
Domains, 3D Domains, UniSTS, PopSet, GEO 
Profiles, GEO Datasets, PubChem Bio-Assay, 
PubChem Compound, PubChem Substance, 
Cancer Chromosomes, Probe, MeSH, Journals 
and NLM Catalog. Links to popular NCBI Web 
pages, such as PubMed, Human Genome, Map 
Viewer, and BLAST, are on the toolbar. There is 
also a link to the "GenBank" database, leading to 
the Nucleotide database.
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PubMed Image Search

You will learn the following:

How to use PubMed to find illustrations for Posters and Talks

Find the research article, then the image
1. In a web browser type "pubmed" and hit enter (http://www.pubmed.org). 

2. Type “wickens eckmann” (these are two author names) in the search field at the top of the page and 
Click Go.

4. Click on entry 3: Eckmann CR, Kraemer B, Wickens M, Kimble J.
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5. PubMed takes you to the Abstract for the article. Click on the Cell Press link.

6. Another Browser window will open and take you to Elsevier. 
 Click on the ScienceDirect link to see the journal article. 
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7. Scroll down to figure 1. Click on the small image of Figure 1 to get the large image.

8. Right mouse click and download the large image to the desktop so you can use it in your poster or 
talk.

Note: Some journals allow viewing of full text articles and the downloading of PDF articles. Always use 
the largest image from the full text article if you can, otherwise download the PDF version of the 
article and open it in Adobe Illustrator or Adobe Photoshop (see, Getting Images from PDF files 
in the next section).
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HighWire image search

You will learn the following:

How to use HighWire.org to find illustrations for Posters and Talks

Find the research article, then the image
1. HighWire is another way to find research articles online. HighWire performs a much wider search than 

PubMed. In a browser go to: http://www.highwire.org
2. Type “eckmann cr” in the Author box, check the "All (including PubMed)" radio button, and then click 

the "Search" button.
Note: Just looking for a Review article? Check the box next to “Reviews only” near the middle-right
of the page.
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3. HighWire will return a list of matching articles. Click the “condensed” format link. If you have more 
then 5 or 6 matches, click on the appropriate number of links per page (10, 20, 30 etc/page).
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4. Notice how HighWire provides a nice, neat, clean list of the matching articles. It lists which ones are available to 
you as ABS (abstracts), FULL (full text article) and PDF (PDF file).

5. On the fourth entry click “Full” and the rest is the same as the PubMed exercise.
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Getting Images from PDF files

You will learn the following:

How to extract images from PDF files as vector illustrations or bitmaps

PDF files
Are a universal text and image file format that works on any computer platform: Windows, Macintosh, 
UNIX, Linux, etc. In general they are small files and may contain vector or bitmap images or both. They 
can be opened in Adobe Acrobat (the full version), Adobe Acrobat reader (limited FREE version),  and 
all Adobe programs including Illustrator and Photoshop. PDF files can be created from any program on 
any computer platform with the full version of Adobe Acrobat installed.

1. Open Adobe Illustrator. Choose File Open and choose sample 
1.pdf from the directory window.

2. When you open a PDF in an Adobe program it will only allow 
you to edit one page at a time.

 Pick page 2 in the Acrobat page dialog box.

3. Once the file opens, choose Select–All. 
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There are two ways that one can save vector images into a PDF file. Notice that the image parts are all 
in one box in this PDF file (below left), therefore this vector image was saved as a bitmap image in the 
PDF file. You could open this PDF file in Adobe Photoshop and crop the bitmap image out to use it in a 
poster or PPT talk, however the image will be low in resolution and of poor quality.

4. Choose File Open and choose sample 2.pdf from the directory window. Pick page 2 in the Acrobat page 
dialog box. Choose Select All. Notice that the vector image parts are highlighted and can be edited in this 
PDF file (below right), therefore this vector image was saved as vector information in the PDF file. You 
can resize and resave this image to use in a Poster or PPT talk with any resolution (see the next section, 
“Images into PowerPoint”, for instructions on how to do this).

Bitmap image

Vector image
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Images into PowerPoint

You will learn the following:

Correct image file formats for PowerPoint talks
How to create PNG files from adobe Illustrator files 

Notes
• All portable and fixed projection units are based on a screen resolution of 72 dpi, therefore all image 

files inserted into a PowerPoint slide should be 72 dpi, or double that amount (150 dpi). They should 
not be 300 or 600 dpi! 

• The PNG file format works best.
• PNG files should be 200% the final size you want, and then scaled to 50% in PowerPoint.
• All sides in a PowerPoint Presentation are 7.5” high and 10” wide.
• When making a slide one should leave space for a title and a comfortable margin for the eye to 

rest in on all four sides. Therefore, 6” x 9”, or less, is generally the maximum area for images on 
PowerPoint slides.

PNG files
PNG-8
Use PNG-8 files for grayscale images, gels, immunofluorescence, tissue samples and EMs. In general, images 
with limited amounts of color and gradients.

PNG-24
Use PNG-24 files for complex colored images, files with large color ranges, color photographs, a person's 
face, etc.
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Creating PNG files
1. Open a PowerPoint presentation and create a new slide. Draw a box to the approximate size and shape 

you want your inserted image to be.

2. Double click on the box and the Format Shape dialog box will open. Click on the size tab. Note the size 
of the box: Height and Width (if your box is not 4" x 4" please change it now...).
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3. Open an image in Illustrator. Use sample 2.pdf - page 2 from the previous PDF exercise.
4. Using the white arrow tool click and drag a selection box over “section D”.
 NOTE: Exactly as it is shown in the example below!!!

5. Copy and paste the image into a new file by choosing Edit Copy. File New. Edit Paste.

6. Your image should look something like the example above. Delete the extra lines around the figure and 
also the letter D and E by clicking on them with the white arrow tool. First click on the white space 
around the figure to deselect everything, then click on a line or a letter and hit the delete key. If you 
are deleting a line you need to hit the delete key twice, once to delete the line and once to delete the 
endpoints of the line.

 You may have created stray points making the above 
deletions. Stray points are the endpoints of lines or text 
anchors that do not contain text. Zoom out to full screen 
by choosing View Actual Size. Choose Select–All. 
Notice if there are any blue highlighted dots around 
the figure. If there are you must choose Select–Object–
Stray Points and then hit the delete key.
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7. From the Select menu choose All.
8. From the Window menu choose Transform and the Transform palette will open (remember, if the 

transform palette is already open it will have a check mark next to it's name in the menu). Make sure the 
"Constrain Width and Height Proportions marker" is on.

9. Click on the little black triangle in the upper right of the transform palette and from the fly out menu 
choose "Scale Strokes and Effects".

10. The Transform palette allows one to move and resize images in Adobe Illustrator. In the “W:” box type 
twice the width, or in the “H:” box type twice the height you noted for the size of the box you drew in 
PowerPoint and then hit the return or enter key. 

 

The default ruler units for Adobe Illustrator is Picas (p) and Points (pt), a standard unit of measure in 
the publishing world... You can change the ruler units to a more familiar standard (inches) or metric 
(centimeters) in the Preferences, Units & Display Performance. Or... you can just leave them as pts. 
and type the unit symbol in any of the dialog boxes, “in” for inches, “cm” for centimeters, “mm” for 
millimeters, “px” for pixels, etc. Illustrator is programmed to figure out what you mean!

11. Now that we have properly sized the image we need to 
get it into PowerPoint.

 From the File menu choose Save for Web. The Save for 
Web dialog box will open.

The box I drew in 
PowerPoint was
4” x 4” so I entered 
8” in the W: field.
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12. Choose the Optimized tab in the upper left. Then configure the settings on the right to match this 
screenshot.

 PNG-8 – Adaptive – Diffusion – Transparency (yes or no) – No Transparency Dither,
 Interlaced box unchecked – Colors: 256 – Dither 100% – Matte: if transparency is checked then choose 

a matte color that is similar or identical to the background in your PowerPoint slide, if transparency is 
not checked choose white from the pull down menu – Amount is grayed out... Web Snap: 0%. 

Note that Illustrator tells you how big your file is going to be before you save it, this allows you to choose 
different format options and see how the files size changes. For PowerPoint talks try to keep file sizes 
under 800K. Then click the save button and save the file to your desktop. 

 PNG-24 only has a transparency option and a Matte: option since you can 
have millions of colors with PNG-24 therefore you do not need color and 
dither settings.

13. Switch to PowerPoint. From the Insert menu choose Picture From file. 
Choose the file you just saved from Illustrator in the directory window 
that comes up.

14. Double click on the inserted image (not the blue box you drew) and the 
Format picture dialog box will open.
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15. Click on the Size tab at the top. Under the Scale section make sure the Lock aspect ratio box is checked 
and then type 50 in the Height or Width box. Then click OK or hit the return or enter key.

 NOTE: We always want to pick 50%... not 48%, not 53% or any other percent!!! The reason we pick 
EXACTLY 50% is because the screen is 72 ppi (pixels/inch) and the file we just exported from Adobe 
Illustrator is 150 ppi. By choosing exactly 50% we are perfectly aligning the image pixels with the screen 
pixels. In a pinch it is fine to choose a percent slightly to one side or the other of 50% but the image 
quality will be slightly degraded. The further you deviate from 50% the more the image quality will 
degrade.
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16.  Move the inserted picture over the blue box we drew earlier. 

17. Click on the blue box and then hit the Delete key.

You now have a perfectly sized image on your slide. Add a title and choose Slide Show–View Show and look 
at your image on screen.
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Creating a poster using Adobe Illustrator

You will learn the following:

Setting up a poster file
Changing the Unit preferences
Formatting and layout of a poster
Titles, identity and location
The abstract
Text boxes and leading
Switching between open files
Placing images
Five general rules for posters
Examples
Printing

Setting up the poster file
Note: Before you try to create a poster, please 

complete the basic Adobe Illustrator 
tutorial starting on page 7.

1. Open Adobe Illustrator.
2. Choose Illustrator, then Preferences, then 

Units & Display Performance...

3. Change Units, General, to Inches (if you 
haven't already done this in a previous 
tutorial).

4. Choose File, New. You will be presented 
with a New Document dialog box. Choose 
RGB for the Color Mode. Almost all of 
the files you create with Adobe Illustrator 
will be done as RGB files. RGB files are 
used in PowerPoint presentations, Posters 
and on the web, CMYK files are used for 
journal illustrations only.

5. Type the size of your poster into the Width 
and Height fields. Since the maximum 
paper size the poster printer can print is 
44”, keep either the width OR the height to a maximum of 43.5”, the other dimension can be up to 
227.54” (19’). Click OK.

Note: All meetings specify what size your poster should be, please check the web site of your particular 
meeting. Common sizes are 24" x 36", 48" x 48", 48" x 60" and 48" x 72". For the "My Molecule" 
presentation in this class we will be using 43" Wide x 30" High.

6. Choose View, then Fit in window. 
7. Save and name the file with your last name, the title of the meeting and the year, on your desktop. This 

will help everyone keep track of your poster when it comes time for reviewing, sharing and printing. 
E.g., lastname_mymolecule_08.ai.



40     ITMC | Department of Biochemistry | UW–Madison ITMC | Department of Biochemistry | UW–Madison      41

Formatting and layout of your Poster
 

Where does one start !?!
 Posters are used to communicate information, therefore you should be thinking about what information 

you want to communicate. A good poster is one that presents information clearly and succinctly. Your 
poster should be ONE thought, ONE process, or ONE idea – NOT MANY!!! It should be as simple as 
possible, with supporting images and short blocks of text that describe those images, most importantly... 
all images must relate to your message!

Title, identity and location 
8. The title should sum up the entire poster in as few a words as possible. The title is generally centered and 

usually in a 100 point, sans-serif, bold, font (Arial, Verdana, etc.).
9. On the next line add your first and last name and the name(s) of any other major contributors to the work 

represented in the poster. The presenting author's name is always first and the major professor's name is 
always last. This line is also centered and is usually 75 pts.

10. Add the location of the presented work, including department, university affiliation, state, zip and 
country. This line is also centered and is usually 55 pts.

Note: All of these fonts and sizes are adjustable, as is the vertical space (leading) between the lines of text. We 
are giving you what we have found to work best over the years. Use whatever you feel is appropriate!

The abstract
All posters should start with an abstract. The abstract should be used as the outline of the poster. The abstract 

should state the following:
 • Why is the presented information important?
 • How does the presented information further the current body of knowledge.
 • A brief explanation of the methods.
 • A succinct statement of the results, conclusions and/or recommendations.
 • References
Some people break up their abstract into sections (introduction, methods, conclusions, references, etc.) and 

then place each of those sections in a different part of the poster.
Note: If you think about it, your entire poster IS an abstract, therefore you don't need a written out abstract. 

This however is not the convention and most people will be looking for a written abstract to follow.
Remember: Posters should help you engage your colleagues in dialog. They should help you get your point 

across to as many people as possible.
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Creating a text box
Note: Adobe Illustrator allows you to 

import text from any word processing 
program. 

11. Take the type tool and click and drag 
out a text box to the size you think 
your abstract will be. Don't worry if 
you do not know how big to make this 
box, you can resize it at anytime! By 
dragging out a text box you are telling 
the program that you want contain all of 
the imported text in this box. 

12. Choose File, Place, then locate your written 
Abstract in the directory structure and click 
OK.

Note: When you import more text then your text 
box can hold, Illustrator will display a small, 
red, boxed, plus sign in the lower right of your 
text box. Do not worry about this just yet!
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13. While the text tool is still active in the text box choose Select All from the menu. This will select all of 
the text in your text box for you.

14. In the Character palette change the font size 
to 24 pts. This is the best presentation size 
for general text on a poster. Your text should 
now look like the example shown right. The 
reason that this text is all crammed together 
is because the leading (the space between the 
lines of text) is set incorrectly for 24 point 
type. In the Character Palette change the 
leading to "Auto" from the leading pop-up 
menu.

15. Highlight just the first line of the text "Topic 
One" and change it to 36 pts. This the best 
size to use for headline text.

16. Remember the little red, boxed, plus sign 
telling you that there was more text to 
display? Let's fix that now. Take the black 
arrow tool (Selection tool) and click on the 
text box. You will see little blue squares in 
the corners and in the middle along the edges 
of the text box. Clicking and dragging any 
one of these little blue squares will re-size 
your text box. Click and drag down the little 
blue square that you see along the middle of 
the bottom edge of your text box, until you 
can see all of the text in your text box.

 Your poster should now look something like 
the example, right.
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Placing images
 
17. From Adobe Illustrator open the sample file, figure 

1.ai. Select all and Copy.
18. Go to the Window menu and choose your poster 

file from the list of open files at the bottom of the 
window menu.

19. Paste in figure 1 and move it below your abstract 
with the black arrow tool.

20. Again take the text tool and drag out a text box 
under the figure, so you can add a caption. Use 24 
pt. font. Write a "dummy" caption of your own. 
Your poster should now look something like the 
example below.

21. Choose File and then Place. Open the sample file 
called Rhodopsin.jpg. Drag this image so it is to 
the right of the abstract. It will be the start of our 
second column.

Note: Bitmap images placed into Illustrator need to only 
be 180 dpi if they are going to be used without any 
scaling. Just like in the Illustrator to PowerPoint 
tutorial on page 31, all images you create for your 
poster should be created at the size you are going 
to use them in the poster. You may use files with 
higher dpi but the extra dpi will not be used by 
the poster printer and will only slow it down. If 
you already have files scanned at higher dpi for 
use in other documents don’t bother resizing them 
down to 150 dpi unless they are at dpi’s higher 
than 600.

22. Create a figure caption for the rhodopsin molecule 
by Shift - Option - Dragging the figure 1 caption, 
just like we did in step number 11 on page 41. See 
example, right.

You can now finish your poster by adding more 
images, captions and text boxes for conclusions, 
references, etc. 

Note: You will need to embed all of your image files 
before you print your poster on the poster printer. 
See page 46 for instructions.
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Five general rules for poster layout and presenting information
1. Author Identification – Make sure you use your first and last name. This allows colleges at the meeting 

to converse with you on a first name basis. It is also a good idea to include your complete address, email 
and phone number somewhere on the poster incase someone at the meeting would like to contact you.

2. Make your research objectives clear – Use large bold headings (36 pts.) that state the following: 
Introduction, Background, Objective, Main point, Aims, Summary, Results, Conclusions, References, 
Contact, etc.

3. Traffic flow – When laying out your poster remember that you are trying facilitate the movement 
of people past your poster. In general, present your poster in columns from left to right. This allows 
participants to read your poster and move out of the way when the next participant starts to read your 
poster. Columns do not need to all be the same size (see examples) but in general, equally sized columns 
have a familiar symmetry.

4. Appearance – Make your poster pleasant to look at! There should be a pleasing use of text and graphics. 
It should not be cluttered or sloppy! Make it easy for the participants to follow the information in your 
poster by using large figure numbers. Make your poster text easy to read (24 pts.). Leave white space on 
all four sides and in between the columns and title of your poster. This allows the reader to rest as they 
proceed through your poster.

5. Balance between graphics and text – DO NOT BE WORDY!!! Cut your text and title to the bare 
minimum. Repeat this mantra over and over in your head, "SHORT AND SUCCINCT"! There should be 
enough text to explain the graphics, and enough graphics to clarify the text! You are not writing a journal 
article!

White space

White space
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Some examples:
The (light blue) AhR therapies poster on the 
previous page is an example of a simple, straight-
forward poster. The information is presented in 
regular columns though it is very heavy on the 
text side and very lean on the graphic side.

The (beige) Whole-genome comparison, poster 
at the top of this page, is an example of a 
methods poster. There are no conclusions. The 
information is presented in three even columns 
but you can see they added a two column figure 
to the bottom of the second and third columns.

The next example on RANKL, is presented with 
all the text on the left and the right and all the 
figures in the middle. Though this is a visually 
striking poster, it is lacking white space around 
the edges and in between the columns.

The last example, DdrA protein, uses a three 
frame approach to present the information. Color 
is used to separate the title (black background), 
text (beige background) and figures (light blue 
background). All of the text is together, as are 
all of the figures.

Remember, it's your poster! It should reflect 
your style and opinions so don't be afraid to 
adapt these lessons to your taste.
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Printing
Once you have finished your poster you should print out a proof, show it to the following people, and weigh 

their advice carefully:
 Yourself (your poster will look different when you see it on paper!), your PI, your lab mates, someone 

who doesn't understand the topic

Embed your images before you submit your poster to the Media Center for printing.
1. From the Window menu in Adobe Illustrator choose Links to open the Link Palette. 

Notice that the first three images in this example do not have the little embedded image 
icon.

2. Highlight the images that are not 
embedded and from little black triangle 
in the upper right corner of the palette 
choose Embed Image. 

Print an 8 1/2" x 11" proof on any printer:
 Choose File, Print and then click on Fit to Page, then Print. If the preview in the lower left doesn't fit the 

page, click on the Orientation and choose Landscape under Media in the middle of the print dialog box.

Print a 13" x 19" proof in the ITMC.
 In a web browser type: http://medialabcolor2.biochem.wisc.edu.
 Click on the "Install Print 

Drivers" and follow the 
directions for your computer 
on how to set up the printer. 
Then follow the directions 
above on how to make your 
poster fit the page. You may 
pick up your proof in room 
401 of Biochemistry between 
the hours of 7:30 am and 
5:30 pm.

Print out the final poster simply 
place a job on the job board, 
http://www.biochem.wisc.
edu/medialab or bring it to the 
ITMC on a USB Flash Drive. 
In general it takes about 45 
minutes to print a 43" x 48" 
poster if you did everything 
correctly. Remember this 
when there are 5 or 6 posters 
in line ahead of yours!
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Creating a poster in Microsoft PowerPoint

Note:

PowerPoint IS NOT a program for creating posters.
Posters created in PowerPoint:
 Are limited to 56" in width by default.
 Are not widely accepted at printshops that print posters. Many places require PDF files.
 Have longer processing and printing times.
 Tend to have problems when creating, editing and printing.
You MUST read through the Adobe Illustrator poster tutorial first (see page 39), as this tutorial 

builds on the knowledge learned there.

You will learn the following:

Setting up a poster file
Slide layout
Formatting palette
Drawing toolbar
Adding and formatting text
Inserting Microsoft Word files
Inserting pictures
Printing your poster

Setting up the poster file
1. Open Microsoft PowerPoint.
2. When you first open PowerPoint you may 

be presented with the following window. 
Choose PowerPoint presentation.

3. PowerPoint will open a new presentation 
and present you with a title slide.
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Formatting Palette
 
4. If the Formatting palette is not open 

on your screen then choose View, 
Formatting palette.

5. Click on the Slide Layout tab at the top of the slide.

6. Choose the plain blank slide.

7. Choose File, then Page Setup...
8. In the page setup change the Width to 43" and the 
height to 30", this is the size we are using for this example. 
Remember though one dimension must be 43" (see page 
39).

9. When you click OK PowerPoint will ask you if you 
want to format your poster (which is just an oversized 
slide) to your current printer's printable area. Click 
Fix.
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Drawing toolbar

 11.  If the Drawing toolbar is not visible along 
the left side of the screen choose View, then 
Toolbars, then Drawing.

Text tool
12. In the Drawing toolbar choose the Text tool 

and then click in the middle top of the poster 
so you can add a title.

13. Type the title into the 
text box following the 
guidelines on page 40.

14. To format the text use the 
Formatting palette:

  Font
  Size
  Bold

  Align Center

(super and subscript)
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15. Save the file with your last name and the title of the meeting and the year. This will help everyone 
keep track of your poster when it comes time for reviewing, sharing and printing. E.g., lastname_
mymolecule_08.ppt.

Inserting Word files
16. Open Microsoft Word.
17. Open the file abstract.doc
18. Select All and Copy the text.
19. Switch back to PowerPoint.
20. Choose Edit, Paste Special.
 Click on Styled text.
Note: DO NOT just copy and paste.
    You will loose the bold, italic
    and greek formatting!

Your poster should look 
something like the 
example, right.
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21. Select all of the text you just imported and change the font to 24 pts. The textbox will jump off the poster 
and you will have to scroll around to find it. Try looking above the poster. 

22. Drag the textbox to the poster area and click on the textbox editing handles. Drag them to make
 the textbox longer and thinner, formatting the text.
 From this:         To this:

23. Choose Insert, Picture, From File... and 
choose the sample file rhodopsin.jpg.

24. Click on the text tool and create a figure 
legend for the rhodopsin figure.

You can now finish your poster by adding 
more images, captions and text boxes 
for conclusions, references, etc. 
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Printing
Once you have finished your poster you should print out a proof, show it to the following people, and weigh their 

advice carefully:
 Yourself (your poster will look different when you see it on paper!), your PI, your lab mates, someone who doesn't 

understand the topic

Print an 8 1/2" x 11" proof on any printer:
 Choose File, Print and then click on Scale to Fit Page, then Print. If the preview on the left doesn't fit the page, 

click Page Setup and choose your printer from the printer list.

Print a 13" x 19" proof in the ITMC.
 In a web browser type: http://medialabcolor2.biochem.wisc.edu.
 Click on the "Install Print Drivers" and follow the directions for your computer on how to set up the printer. Then 

follow the directions above on how to make your poster fit the page. You may pick up your proof in room 401 of 
Biochemistry between the hours of 7:30 am and 5:30 pm.

Print out the final poster simply place a job on the job board, http://www.biochem.wisc.edu/medialab or bring it to the 
ITMC on a USB Flash Drive. In general it takes about 45 minutes to print a 43" x 48" poster if you did everything 
correctly. Remember this when there are 5 or 6 posters in line ahead of yours!
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Converting a PowerPoint talk to a PowerPoint poster

You will learn the following:

Setting the Slide masters
Viewing two PowerPoint files at the same time
Copying and pasting between a talk and a poster

Create the poster file
1. First make sure you read and understand pages 39-45. Second, follow steps 1-11 on pages 47-49.
2. Save the file with your last name and the title of the meeting and the year. This will help everyone 

keep track of your poster when it comes time for reviewing, sharing and printing. E.g., lastname_
mymolecule_08.ppt

3.  Open the sample file talk.ppt.
4 In the talk.ppt file choose 

View, Master, Slide Master.

5. Click on the title box and note the font, font size and font style (bold, italic, etc.). In our example it's Arial 
and 32 pts. Then click on the 1st bullet line of text and do the same (Arial 22 pts.). Continue this with 
each line of bullet text.

6. Choose Window from the menus at the top of the screen and then pick your poster file from the list of 
open files you'll see there.

7. In the poster file choose View, Master, 
Slide Master. 

8. Select all of the text in the title box 
and change it to whatever it was in the 
talk.ppt file. In our example that was 
Arial 32 pts. Select the text of the first 
bullet text and do the same. Proceed 
through each of the other bullet text 
strings in the slide master until the 
Slide master of the talk and the Slide 
master of the poster are the same.

Poster Slide Master before...

Poster Slide Master after...
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9. While still in the poster file choose View Slide.

10. Choose Window, Arrange All.

11. Click on the talk file window (right side) and choose View Slide. If your slide is too big change the size 
to Fit in the scale window.
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12. In the talk file, Slide one, Select All and Copy. Click on the poster file and Paste.

13. Switch back to the talk file and go to slide two. Select All and Copy. Click on to the poster file and Paste. 
Repeat for all slides in the talk (six in our example).

14. Once you have moved all of your slides over to the poster file, close the talk file. Make the poster file full 
screen and complete your poster using the information on pages 47-52.

Note: Little things may change when you copy from one file to the other. Remember to go in and check all 
the details!
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The spectrum of light:
Red - Orange - Yellow - Green - Blue - Violet

The spectrum of light:
Red - Orange - Yellow - Green - Blue - Violet

Color basics – What is color? Terms and definitions

Pigment color wheel:
Red - Orange - Yellow - Green -
Blue - Violet 
This is the best representation
of the real spectrum that we can
achieve with ink/toner on paper.

Magenta:
This is not a natural color. It is made
by combining the two ends of the
spectrum: many people
find it “shocking”.

Primary, secondary and opposite colors work very well together but only in printed materials, think sports 
logos. They do not work well together on computer monitors e.g., do not use red text on a green background 
or orange text on a blue background, etc. as the text will look like it is vibrating on the screen!

Primary colors:
Red - Yellow - Blue

Secondary colors:
Orange - Green - Violet

Opposite colors:
   Violet - Yellow         Red - Green          Blue - Orange

Yellow-green:
Chartreuse (Fluorescent green)
is the exact middle of the spectrum:
many people find it “alarming”.

Red:
Is a very attention getting color for humans,
probably because it is the color of blood. Use it 
only to call attention to a special point or idea.

Spectral color wheel:
Red - Yellow - Green - Cyan -
Blue - Magenta
These are the actual physical
colors of the light spectrum.
These are the colors you see on
computer monitors.

1.

2.

Primary, secondary and opposite colors work very well together but only in printed materials, think sports 
logos. They do not work well together on computer monitors e.g., do not use red text on a cyan background 
or magenta text on a green background as the text will look like it is vibrating on the screen! However, yellow 
text does work well on a blue background. 

Primary colors:
Red - Green - Blue (RGB)

Secondary colors:
Cyan - Magenta - Yellow (CMY)

Opposite colors:
    Red - Cyan          Green - Magenta     Blue - Yellow

Special colors: Only use these colors with specific intent, use them sparingly.3.

H. Adam Steinberg - hsteinbe@wisc.edu



The spectrum of light:
Red - Orange - Yellow - Green - Blue - Violet

The spectrum of light:
Red - Orange - Yellow - Green - Blue - Violet

Color basics – What is color? Terms and definitions What colors do I use?
Follow these simple guidelines for color combinations that work!

Look to nature
Whenever you need inspiration on what colors
to use just look to nature. It is always correct!

Pigment color wheel:
Red - Orange - Yellow - Green -
Blue - Violet 
This is the best representation
of the real spectrum that we can
acheive with ink/toner on paper.

Warm colors:
Red - Orange - Yellow - Brown - Beige
Generally favored psychologically by
women, work well together as a set.

Monochromatic warm colors:

Cool colors:
Violet- Blue - Green - Gray
Generally favored psychologically by men,
Work well together as a set.

Monochromatic cool colors:
Three or four shades of the same color work well together as a set.

Any pair of Pigment colors:
Work well together as a set, the exception is Red - Orange.

Blue - Violet Blue - Green Green - Yellow

Yellow - Orange Red - Orange Red - Violet

Magenta:
This is not a natural color. It is made
by combining the two ends of the
spectrum: many people
find it “shocking”.

Primary, secondary and opposite colors work very well together but only in printed materials, think sports 
logos. They do not work well together on computer monitors e.g., do not use red text on a green background 
or orange text on a blue background, etc. as the text will look like it is vibrating on the screen!

Three or four shades of the same color work well together as a set. However 
yellow on white does not have enough contrast unless it is stroked with a darker 
color. This is especially true when displayed on a computer screen.

Primary colors:
Red - Yellow - Blue

Secondary colors:
Orange - Green - Violet

Opposite colors:
   Violet - Yellow         Red - Green          Blue - Orange

Neutral colors:
Work well as a set, work well with any primary or secondary color.
Brown: any two opposite pigment colors will make brown e.g., red + green.
Beige: is light brown.
Gray: mix the three primary colors or the three secondary colors to get gray.
Black: made from a mix of all pigment colors or a subtraction of all spectral primary colors.
White: is the absence of all pigmented colors or the addition of all spectral primary or secondary colors.

Yellow-green:
Chartreuse (Fluorescent green)
is the exact middle of the spectrum:
many people find it “alarming”.

Red:
Is a very attention getting color for humans,
probably because it is the color of blood. Use it 
only to call attention to a special point or idea.

Spectral color wheel:
Red - Yellow - Green - Cyan -
Blue - Magenta
These are the actual physical
colors of the light spectrum.
These are the colors you see on
computer monitors.

1.

2.

Primary, secondary and opposite colors work very well together but only in printed materials, think sports 
logos. They do not work well together on computer monitors e.g., do not use red text on a cyan background 
or magenta text on a green background as the text will look like it is vibrating on the screen! However, yellow 
text does work well on a blue background. 

Primary colors:
Red - Green - Blue (RGB)

Secondary colors:
Cyan - Magenta - Yellow (CMY)

Opposite colors:
    Red - Cyan          Green - Magenta     Blue - Yellow

Special colors: Only use these colors with specific intent, use them sparingly.3.



10 Tips for Great Scientific Illustrations

1. Know your audience.
       Don’t illustrate what they already know, clarify what they don’t.
2. Tell your story. Started here (hunch), did this (experiments), and ended up
       somewhere (conclusions). Keep the components (colors, shapes, views,
       etc.) consistent from illustration to illustration.
3. Create interest and stimulate imagination.
4. Control: move the reader through the illustration
       Left to right, top to bottom.
5. Color: only when necessary, use it to direct focus.
6. Humor: but only if appropriate to the subject matter.
7. Human: add face, hand, body, etc. humans love to see humans.
8. New ideas: require simple illustrations.
      Let the idea take focus not the illustration.
9. Technical text = technical graphic, add parts or sections to clarify.
10. In general, never use the defaults, they are always WRONG!

Never hesitate to invest in good graphics. They pay for themselves by clarifying
your research and data to those around you.

H. Adam Steinberg - hsteinbe@wisc.edu
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